
Common Tasks
On this page:

Unzipping a file
Zipping some files
Attaching zip files to outgoing mail
Backup and mobile work (sync update)
Split/Merge files
Making a self-extracting archive
Using Copy mode

Unzipping a file
      If you know where the file is...

1.    double click on the file from Explorer or File Mgr.
2.    Zip95 or IZ-Win will open & show contents of the zip file
3.    Files will be placed in the directory open on the right-side
4.    you can drag files out (Zip95)
5.    or click the UNZIP button (both) 
         (if you don't select any files, it unzips all of them)

      If you don't know where the file is...
1.    run Zip95 or IZ-Win from its icon or the start menu
2.    in the left side panel, click the C: drive 

3.    then click 
4.    on the find screen, click start
5.    a list of all the .zip files will appear - pick one!
          then go to step #2 in the procedure above
      If you want to install software from the file...

1.    run Zip95 or IZ-Win from its icon or the start menu
2.    click drive & folder icons on left side until you find the file
3.    click the zip file to select it
4.    you'll get a message offering to run INSTALL or SETUP
5.    click OK
6.    the install will run AND you'll get a temp file deletion message
7.    AFTER the installation, click YES on the temp file deletion

Zipping some files
      From Explorer...if you installed Explorer right-click popups,

you can right click on the files & select Zip95
      From File Manager...select the files, then menu items Zip|Zip
      From Start Menu...select Programs | MCTools | Zip95
      From Pgm. Mgr...run IZ-Win from its icon

Zip95 or IZ-Win will appear with your files selected on the right.
 - if no files are selected, it will zip ALL of them
 - to zip subfolders, hold down CTRL key as you select them

Proceed according to where you want to put the zipped files...

      To a new archive in the same directory...just click ZIP,
you'll be prompted for a name for the zip archive file.

      To add them to an existing archive...
1. click the left side drive & folder icons until you are in the folder where the existing archive appears 

at the upper left



2. click on the existing archive to select it
3. click ZIP

Attaching zip files to outgoing mail
1.    create the zip file as described above
2.    compose a mail message
3.    either:

- drag the .zip file into an OLE aware mail pgm (e.g. Exchange)
- use the File | Attach or similar menu items of your mail program

4.    send the message
      NOTES:

- if you send internet mail, select MIME encoding in your mail pgm.
- do not send files over a couple hundred KB as mail attachments
      (instead, upload them to an FTP site or web page)

Updating backups or mobile work
1.    insert the floppy with the backup or mobile work
2.    either:

- run Zip95/IZWin & select the floppy zip file on left
- run Explorer and double click the zip file

3.    right click on the lower left content window
4.    from the popup menu, select get source window

(or navigate to where your source files are on the right side)
5.    click the sync upd button
6.    select any new files you added not already on the floppy
7.    click the ZIP button

Updating your working files from backup or mobile floppy
1.    follow steps 1-5 above
2.    select any new items in zip file not on your hard drive
3.    click the UNZIP button

Split/Merge large files
You can easily split large files up for storage on limited media, such as floppies, or for sending via e-mail.  
ANY type of file can be split, .zip or other.    You do not even need to have IZ-Win to put the file back 
together!

SPLITTING FILES
1 select split/merge mode on the mode box.
2 Select the file to be split in the left window of IZ-Win. 
3 Set the right window of IZ-Win to the location for the split parts.    If this is a floppy drive, you will be 

prompted to    change the floppy after each file is written.
4 Click the Split button (which will be showing), or select Archive|Split
5 You will be prompted for the split size, in KB (kilobytes).    The default will be 1455, which works well

for 1.4meg floppies. The actual split size will be rounded to a 4k multiple.
6 Test to be sure you can re-merge & use the file (such as with Archive | Test or by unzipping the last 

element) before depending upon it for critical data.

MERGING (re-joining) FILES using IZ-Win
1 Set the left window of IZ-Win to the directory where the re-joined file will be.
2 Select the file parts to be merged from the right window.    If you are merging from floppy, start with 

the first floppy.
3 Enter the file name for merged files when prompted.
4 You will be prompted for additional floppies, if any.



MERGING WITHOUT IZ-Win
1 Copy all file parts to your hard drive.
2 Invoke the DOS prompt, and change to the directory where you put the file parts.
3 Use the COPY command with the /b option and the + operator.    For example, to re-assemble a 2-

part file named TEST.ZIP:

copy /b test.001+test.002 test.zip

Making a self-extracting archive
      From a .zip file...

1.    select the zip file in the usual way
2.    from the Archive menu select make .exe
3.    you will be asked to confirm an extractor:

- change 32 to 16 for compatibility with Win 3.1
4.    Your self extracting archive has the same name as your .zip file, but with the extension .exe

      From a directory using LZ Compress...
The advantage of this method is more flexible expansion options
and usually a smaller archive, since the LZ-Expand built into
Windows is used for the expansion.
1.    if you don't already have it, obtain COMPRESS.EXE from 

ftp://ftp.microsoft.com/developr/win_dk/sdk-unsup-ed/toolkit.zip
(716kb, keep only compress.exe, put it in your dos or windows folder)

2.    navigate to the folder where your files are on both left & right sides (this whole folder will be 
included)

3.    select the LZ compress/expand mode:
4.    from the archive menu, select make .exe
5.    you'll have the opportunity to specify a program to run on expansion
6.    select the 16 or 32 bit version of the extractor - the 32 bit version allows the user to select an 
expansion directory, but is larger (of course, it also recognizes long file names)

Using Copy Mode
Select the copy/browse mode if you just want to move files of all types from side to side
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Top Control Bar

Bottom Status Bar



File Finder    -    Click |  | on the left side to display this:



Left Side ZIP Files

- single click to select a file or change folders
- double click to unzip & run an item from a zip file
- use Options menu to adopt standard windows selection style if you prefer

Explorer Menus

    

right-click on empty space for 'new' menu right-click on a file to zip it
double-click on a zip file to open zip container view

The install program also adds the "Text View" menu item (if you select this option), for quick browse of 
files with unknown extensions.    In Windows 3.1, IZ-Win adds a ZIP menu item to the File Manager.    
In addition to using these menus, you can drag files into an open IZ-Win or Zip 95 window.    With Zip 95 
you can also drag them out into other applications.

Note: if Explorer attempts to open unrelated files with Notepad, you can disable these menus by running Zip95 Uninstall.    This is 
particularly a problem with the MS Office shortcut bar.    



Overview of Zipping & Unzipping

What this program does
IZ-Win & Zip95 show the contents of your disk drive, similar to Explorer or File Manager.    In addition, 
they also show the contents of special ".zip" archives, and are able to convert those contents to and from 
the regular file format.    IZ-Win & Zip95 are compatible with PKZip 2.04g, WinZip 6.0, and most other 
zip/unzip programs.    IZ-Win is the Win 3.1 16-bit version.    Zip'95 is the Windows 95, 32 bit version.    Zip 
95 adds long file names, full OLE drag & drop, increased capacity, and faster performance.

Other features
- Print directory listings
- Instantly display & sort file dates or sizes
- Find lost files, even searching within zip archives.
- Interface shell to compress.exe for software developers.
- Make self-extracting archives.    (a zip file which can be run as a program to automatically unzip its contents)

What to use it for
- Unzip files you have downloaded so you can view or install them.
- Bundle files into a single archive for e-mail attachment or internet upload.
- Transport or backup more & larger files on floppy, more quickly.
- Increase disk space by zipping less frequently used files.

(unlike automatic compression programs, this is completely under your
control, and does not make your computer hard to upgrade and maintain)

What is ZIP
A .zip file (or archive) contains one or more normal files which have been compressed by eliminating 
repeated information.    The more repetitious the material, the smaller the compressed version of the file 
will be.    The reduced size, along with the bundling of several files into one, and its evolution as a 
widespread standard, makes the .zip format ideal for the above uses.    Here is a guideline to how much 
compression you can expect:

File Type Description Compression Amount
.TXT plain text document about 50% or more
.DOC word processing doc. about 50% or more
.BMP windows bitmap image 90% if computer generated, 50% if scanned
.TIF tagged image format 90% if computer generated, 50% if scanned
.GIF compuserve image none, GIF is already a compressed format
.JPG JPEG image none, JPG is already a compressed format
.XLS spreadsheet about 70%



Seeing Extensions
The default configuration with Windows 95 is not to display the file types.    To see them, from the Explorer
menu, select View | Options... and uncheck    [ ]Hide MSDOS Extensions.



Zip95 / IZ-Win Order Form MediaComm Software
print & sent to: 5238 Appleblossom Ln.

Friendswood, TX 77546

    Zip95 (for Windows 95), registration code, $15 
    IZ-Win (for Windows 3.x), registration code, $10 
    Install diskette, sent via regular mail, $3 additional    ($8 outside U.S.)
    Site License, ___ additional copies at 1/2 off (includes 1 install diskette)

Total enclosed $_______ U.S.,  check or money order
 credit card

Now accepting VISA, MasterCard, Discover & American Express for your convenience.    For ordering via e-mail, see the on-line 
form at http://members.aol.com/rlshuler/order.htm

__________________________________ ______________ 
card number expiration date

__________________________________
name on card

__________________________________  (required for reg. code only purchase, or for 
e-mail ID receiving program upgrades, will not divulged)

ship to:

_____________________________ -(required for install diskette,
name  or payment other than by money order)

______________________________
street & unit

_____________________________
city, state, postal code

_____________________________
country

Terms & License:    Paid, registered users may install and use this software on one office, one home and one portable machine which they 
regularly use, and receive technical support via e-mail.    All sales are guaranteed satisfaction within 30 days.    Orders usually filled within 1-2 
days.    Allow 7-10 days for delivery of shipped items.    No refund on shipping charges.    Contact MediaComm before returning any item.    
Please try the demos before ordering to see if you like the product, and to see if it works well on your system.    MediaComm assumes no liability 
and issues no warranty for any loss due to use or malfunction of product, except refund of purchase price within the stated period.    Always be 
sure your system is backed up!    The programs zip.exe and unzip.exe were largely produced by the InfoZip group, and may be retained and used 
as command-line utilities without purchasing Zip95 or IZ-Win.    See http://quest.jpl.nasa.gov/Info-ZIP/Info-ZIP.html.    Thanks for selecting 
MediaComm products!!

______________________________ _____________
signature (for credit card purchase) date



Right Side Buttons & Files

(note: image is color reduced - may look slightly different than actual)

- single click to select a file or change folders
- double click to open & run a file
- hold down CTRL key to select folders for zipping (without changing folders)
- use Options menu to adopt standard windows selection style if you prefer



Tips & Tricks
On this page:

File Dates, Sizes, Folder Sizes, Printing
Shortcuts: <> Quickchange, Invert, Memory, Popup Menus
Drag & Drop
Warnings
Zipping Sub-Directories
Zip/Unzip Options
LZ-Compress/Expand + autorun install
IZ-Win File Mgr. Menus

File Listing Features
 - Use the dates button to see the most recent files.

 - Use the sizes button to see the largest files, AND to see the sizes of FOLDERS 
including all their content, no matter how many subfolders.

 - Use the file types box  to list files of only certain types.    For example, 
entering DOC,XLS would list only the Word & Excel documents in a folder, or entering 
BMP,TIF would list only these two highly compressible image types.

 - Use File | Print to get a hardcopy of the files you have listed with one of the above 
techniques.

Shortcuts
 - Use the < > buttons to get the same directory on both sides.

 - Use the memory/recent menu to exactly repeat a zip transaction routinely (or just 
use it to quickly set up directories on both sides, and clear the selections)

 - Use the invert button to reverse all your selections - for example, maybe you want to 
zip some files in a directory and delete the rest:    1. select, 2. zip, 3. invert, 4. delete!    
To select all, first clear, then invert.    You can do this for one side at a time using the 
right-click popups, or for both sides at once using the buttons.

- You can right-click over any of the three main panels to get a popup menu of 
applicable commands.    You can also right-click in explorer, if you selected that install 
option.

Drag & Drop
 - With Zip95, you can open several zip files in the container view, and drag content 
files between each other and between them and regular Explorer windows.

 - When dragging files, hold down the CTRL key for copy mode, and the SHIFT key for 
move mode.    Holding down CTRL-SHIFT gives link mode.    In Zip95, this is the default 
for some drag-drop combinations.    What it does is change directories to the one where 



the "link" files are.    It does not create a "shortcut" (use Explorer for that). 

Warnings!
 - Do not zip directly onto a nearly full floppy!    Use several smaller zip files on a 
floppy, and leave some free space -OR- zip onto the hard drive and copy to the floppy.    
The zipper creates temporary files on the disk where it is zipping.

 - To recycle a file, drag it to the recycle bin.    To delete a file permanently and free 
the disk space, use the delete button.    Careful, it will delete whole directory trees, 
including hidden and archive files, irretreviably!

 - If you use Zip95 with COMPRESS.EXE or File Mgr., your Zip95 path should consist 
only of short folder names with no spaces.

Zipping Sub-Directories:
You may zip entire subdirectories.    Do this as follows:

1 Select the subdirectories from the right side of either IZ-Win or the file manager - (but do not 
change into any subdirectory!)

2 From IZ-Win, you must press the CTRL or SHIFT key when selecting a directory if you want to 
avoid changing into it.

3 Enter a .zip file & select ZIP.

NOTES:
- 'name not matched:' messages with no name listed can be ignored.
- IZ-Win will restore the subdirectories within the current working directory when unzipping, unless 

you use the -j option
- PK-Zip by default does not restore subdirs. - consult your documentation
- If you get "too many selected files" while trying to zip [windows] directory, it is because of the also 

large [system] subdirectory.    Try zipping these separately.

Zip/Unzip Options:
Certain InfoZip options may be set from the Options menu.    Each option is preceeded by a '-', and they 
are separated by 1 blank space.    The options are case sensitive, i.e. '-C' is not the same as '-c'.    The 
options you are most likely to use are shown on the menu prompt.    For a complete list of options, run 
ZIP.EXE and UNZIP.EXE from Program or File Manager, or the taskbar RUN prompt.

COMPRESS.EXE (for developers)
This is another type of compression provided by Microsoft    It is often used by install programs.    IZ-Win 
facilitates use of compress.exe, even for self-extracting archives!

Obtaining COMPRESS.EXE (you may already have it)
COMPRESS.EXE can be downloaded from Microsoft via FTP at no charge.    Use a web browser or ftp 
program to go to the URL ftp://ftp.microsoft.com/developr/win_dk/sdk-unsup-ed/ and download the file 
TOOLKIT.ZIP (about 716kb).    Unzip the file compress.exe and put it in c:\windows or c:\dos (some place 
that's listed in the PATH statement in your AUTOEXEC.BAT file).

Changing from ZIP to COMPRESS Mode:
The OPTIONS menu allows toggling between ZIP and COMPRESS(LZ) modes, or use the mode box on 
the control bar.    In COMPRESS mode, the center buttons will read "Compress" & "Expand", and all files 
will be listed in the zip directory.    "Compress" will use Microsoft's COMPRESS.EXE, which must be in 
your PATH statement! 



There are 2 distinct uses of this mode:    

(1) Use the [<-Compress] button to create LZ compressed files for use by most install programs.    Use 
[Expand->] to uncompress any such file.    IZWin will NOT rename files, so compressed and 
uncompressed must be in different directories.

(2) Use "Make .exe" from File menu to build an all-windows very low overhead self extracting, self 
installing (or auto-running) program.    This is described below.

In COMPRESS mode, if you select "File | Make .exe", the program UNC16.EXE or UNC32.EXE (chose 
either) is bundled with the files using the name you supply.    Everything selected on the right side will be 
bundled and compressed.    It is recommended that you NOT compress the individual files first.    If you do,
they may take up slightly more space (due to double compression) and will still be compressed when 
unbundled!    Since LZ-Expand is part of every Windows system, UNC16.EXE can be VERY small.    
UNC32.EXE is somewhat larger, but handles long file names and allows the user to specify where the 
files will be uncompressed.    

Auto-Installation
Make .exe will ask for the name of a program (such as install.exe) that you want to run when the files are 
expanded.    

- If you supply a name, the file will be run, and the temporary files will be deleted (if user confirms).
- If you do not supply a name, the files are expanded only.

IZ-Win File Mgr. Menu
IZ-Win (only) adds a menu item "Zip" to Windows File Manager.    Zip95
users have the option of adding right-click popups during installation.    The
following applies only to IZ-Win used with File Manager.

- You need not go hunting for IZ-Win - it's there where you need it!
- Zip/Unzip selections bring up the IZ-Win screen with preselected files so you don't have to make a 

2nd hunt thru directories for them!
- When you wish to return to File Mgr., "Exit" IZ-Win

Here are the menu functions:

    Zip|Zip - ZIP selected files 
    Zip|Unzip - UNZIP selected .zip file
    Zip|Set Zip/Dir - Preselect a target .zip file or compress dir. or reference sync directory (To select a 

directory, get in the directory you want & don't highlight any files - then select this menu
item.    Next time you do a Zip or Sync, that directory will be used.)

    Zip|Sync Files - Backup to a .zip file or ordinary directory copying only the changed or new files - also 
use for restoring directories & uninstalling. (brings up IZ-Win with proper options set for 
your review)

    Zip|Text View  - View a file that is probably text
    Zip|Text Find  - (This menu item optionally appears if you have obtained the TextFind program - 

install it to the same folder as IZ-Win & restart Windows)
    Zip|Description - View or Create Annotation for selected file
    Zip|Stats - Display's file date & size quickly & easily.

    "Set Archive" with no file selected sets only the directory where IZ-Win will put the next .zip file you 
create from IZ-Win (see below).

    "Zip" with a directory folder selected in the files window (right side) of File Mgr. zips the entire directory, 
retaining the directory name.    This is handy for zipping several directories in a single .zip file. since they 
come out separate on unzipping.    If you get "too many selected files" see discussion in IZ-Win Screen 



section.

    "Text View" will run Notepad on the selected file - very useful for oddball extension names or .bat files 
that you can't double click on safely. Makes it easy to examine a shareware archive after unzipping. 



Zip Container View (Zip95 only)
This view comes up when you run a .ZIP file, or you can switch to it from the View menu.    It is useful for viewing large zip files 
(expand to full screen for multi-column content view), and as a drag-drop source or target when dragging in and out of zip files.    
Multiple container views can be opened for dragging between zip files.






